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Introduction
Overview
Welcome to Ontrack® PowerControls™, a powerful, yet easy-to-use application for searching,
recovering, restoring, and managing data at a granular level in Microsoft® Office SharePoint®
Server environments.
With Ontrack PowerControls, you can perform source and target functions on Microsoft Office
SharePoint Server data. It also provides a robust search function on source items to quickly and
easily find, recover, and restore content – such as documents, lists, libraries, and folders – or entire
Microsoft Office SharePoint Server sites.
Ontrack PowerControls works with your existing database so can restore content from MDF files,
NDF files, and LDF files directly to your Microsoft Office SharePoint Server target, or to a different
server. Microsoft Office SharePoint Server backups can be extracted from tape or disk-based
backups using the Direct Method of extraction.

Five Major Reasons for Using Ontrack
PowerControls
There are five primary ways you can benefit from using Ontrack PowerControls:
1. Minimizes the time to restore an individual document, item, list, folder, site, or library.
Ontrack PowerControls can slash restore time, making it possible to granularly restore items from a
previous full backup. Items from database backup can be restored individually, giving you restore
flexibility and eliminating the need to perform to a full site restoration in order to find the items you
need.
2. Eliminates same site restore constraint.
By eliminating same site restore constraint, Ontrack PowerControls gives you the flexibility to restore
to origination or alternate locations. With Ontrack PowerControls, you can restore directly into your
production Microsoft Office SharePoint Server or a file system.
3. Minimizes the time to locate all matching specific criteria.
Ontrack PowerControls includes an Advanced Find feature that can search across all content
databases in an archived Microsoft Office SharePoint Server file, rather than bringing an old
backup back online for analysis. You can search by a variety of criteria, including keywords,
subject, date, specific users, and file and attachment data.
4. Maintains data integrity of the Microsoft Office SharePoint Server source.
Ontrack PowerControls does not change the contents or metadata of the source content
database, and maintains data integrity of the source by performing read-only operation.
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5. Minimizes the costs involved in restoring lost items.
Ontrack PowerControls eliminates the need to have an expensive restoration server available, as
well as the cost associated with the extra steps required to separately import sites back into
Microsoft Office SharePoint Server to find items needed. Also, since it can read your existing
content database backups, there is no need to purchase proprietary software for creating the
backups. Your backup process can remain the way it is today.

About the Free Trial
After installation, Ontrack PowerControls operates as a Free Trial by default until a license file is
applied. The Free Trial of Ontrack PowerControls is limited in functionality and time-limited to 30
days of use.
With the Free Trial, you can:
n

Open sources

n

Open targets

n

Perform searches

If you would like to have full functionality, or learn more about the purchasing options and product
information for Ontrack PowerControls, visit our website at www.ontrack.com.

Readme File
The Ontrack PowerControls Readme file contains additional information about the Ontrack
PowerControls, including:
n

Supported environments

n

Licensing

n

Upgrading from previous versions (if applicable)

n

Limitations

n

Technical support

The Ontrack PowerControls Readme file is included in the electronic package.

Getting Help
Ontrack provides you with the following ways to get help with Ontrack PowerControls:
n

Online Help

n

Technical Support
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Online Help
Online Help includes all of the information in the user guide. You can quickly access this
information using the following online Help tabs:
n

Contents: Displays a hierarchical view, similar to the Contents of the user guide.

n

Index: Provides a list of key words to locate specific topics.

n

Search: Offers a full-search of the Help file.

To start online Help
n

Do one of the following:
l

On the Help menu, click Contents

l

Click

l

Press the F1 key.

on the toolbar.

Context Sensitive Help
You can click the Help button that appears on many of the dialog boxes when using Ontrack
PowerControls to open the online Help topic related to the current task.

Tooltip
When you position the pointer over a tool or control and pause, a message box appears with a
definition of your selected item.

Technical Support
If you have questions or problems not answered in the user guide or the online Help (F1), contact
our Technical Support group. When reporting an issue, please include any information that might
help us diagnose the problem. The following details are often the most helpful:
n

The version of Ontrack PowerControls you are using (on the Help menu, select About).

n

The versions of Windows operating systems that you are running.

n

The version of SQL Server that contained the source database file.

n

The version of Microsoft Office SharePoint Server for the source data.

n

The version of Microsoft Office SharePoint Server for the target.

n

The circumstances and sequence of steps that led to the problem.

n

The text of the error messages (if any appeared), and the contents of the Details window.

n

A list of other Windows-based programs that you were running when the error occurred.

For more information, please see "Contact Information" at the beginning of this user guide.
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Chapter 1: Looking at the Interface
Overview
This section describes the main window of Ontrack PowerControls and details the functions of the:
n

Menu bar

n

Toolbar

n

Source and Target panes

n

Source Item and Target Item lists

It also explains how to:
n

Change the appearance of the main window

n

View the properties of a content database

n

View the target in a browser

n

Use the Preferences dialog box

Main Window
The main window of Ontrack PowerControls is where you do most of your work. The main window is
divided into four panes by two split bars: the two Source panes above the two Target panes.
The Source panes display the source MDF, NDF, and LDF file(s). The left Source pane contains the
content database tree view. When you select an item in this pane, its contents appear in the right
Source pane.
The Target panes act as a container for the restored items on the target server. The left Target pane
contains the Microsoft Office SharePoint Server nodes and contents copied, dragged, or added
through the Data Wizard. The right Target pane displays the list of the contents of the item selected
in the tree view on the left Target pane.
Any functions that can be performed on a source data item or target items can be accessed
through the menu bar, the toolbar, or the right-click context menus.
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Figure 1-1: The main window with its four panes.
Key items on the Ontrack PowerControls main window:
1. Menu Bar
2. Toolbar
3. Source Location
4. Source Pane
5. Source Message List
6. Target Location
7. Target Pane
8. Target Message List
9. Status Bar

Menu Bar
Figure 1-2: The menu bar in the main window
The menu bar contains all of the commands for Ontrack PowerControls. The menu commands,
submenu commands, and resulting dialog boxes are discussed fully in the sections that focus on
those specific commands.

Toolbar
Figure 1-3: The toolbar in the main window
The buttons on the toolbar perform the following functions:
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Icon

Function
Open Source opens the Source Path Selection page of the Data Wizard, where you can add
.mdf, .ndf., and .ldf files.
Open Target opens the Target Server Selection page of the Data Wizard, where you can enter
the target Microsoft Office SharePoint Server name, configuration database, and authentication.
Copy copies onto the clipboard the selected item(s) in the source list or list and folders from the
tree view.
Paste inserts the items from the clipboard into the selected list or folder in the Target pane.
Export displays the Export Options page of the Export Wizard, which lets you export an item to a
local or network drive destination.
Find displays the Find in Sources dialog box, which lets you specify the desired search criteria
for finding items in the Source pane.
View Help displays Ontrack PowerControls Online Help, which includes all of the information in
this user guide and more. Online Help lets you quickly access this information by using a
Contents, Search, or Index tab.
Ontrack on the Web takes you to the Ontrack website (www.ontrack.com), providing you with
additional information on products and services by Ontrack.

Shortcut Menu
You can access many of the same commands available on the menu bar and toolbar by rightclicking the mouse to open a shortcut menu. The contents of the shortcut menu depend on
whether you right-click in the Source or Target pane. This manual aims to explain how to use
commands on the menu bar and toolbar, and doesn't always specify when you can use the
shortcut menu. Once you become familiar with Ontrack PowerControls, the commands available
to you on the shortcut menu should become apparent.

Source Panes
The Source pane displays the content database files that you selected in the Source Path
Selection page of the Data Wizard. The source tree can display one or more sources. It displays the
source as a tree view and mimics the hierarchy of the database.
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Figure 1-4: Source pane
For more information on using the Source panes, see "Data Wizard: Source Path Selection Page"
on page 21.

Source Item List
The Source Item list displays the source items in a list with columns depending on the type of source
list. The columns can include leaf name; attachments, if any; title; content type; UI Version;
modified and created on dates; created by; and modified by.

Figure 1-5: Source Item List
You can open a source data list item using the native application with which it was created by
right-clicking on the item and selecting Open File in the context menu. If the native application for
the item is not available on your computer, a dialog box appears where you can select the
application to view the item data. If you want to view the metadata of an item that can be
opened with the native application, right-click and select Open Item.
Source Item List Context Menu
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Source list items have several functions available through a context menu. You can right-click on
an item or multiple items to display a context menu with the following options available:
n

Open Item: Displays the metadata of an item in a new dialog box or open the native
application.

n

Open File: Open File is available if the item has a content stream. Only one item can be
selected at a time.

n

Copy: Copies the selected item or items to the clipboard.

n

Select All: Selects all of the items in the list.

n

Export: Opens the Export Wizard where you can save the selected item to a selected
location.

n

Save Attachments: Opens the Save Attachment dialog box where you can save the
attachments of the selected item to a selected location.

n

Previous Versions: Opens the Previous Versions dialog box where you can view the previous
versions of the item and copy them to a selected location or to the Target pane.

Some context menu items are unavailable when multiple items are selected; for example, "Open
Item," "Open File," "Save Attachments," and "Previous Version" functions.
For more information on all of these functions, see "Using Ontrack PowerControls" on page 20.

Target Panes
Ontrack PowerControls can connect to target Microsoft Office SharePoint Servers. One or more
targets can be opened at a time. The target data appears in the Target pane, which mimics the
hierarchy of the database.

Figure 1-6: Target pane
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Target Item List
The Target Item list displays the target items in a list with columns depending on the type of target
list. The columns can include leaf name; attachments, if any; title; content type; UI Version;
modified and created on dates; created by; and modified by.

Figure 1-7: Target Item List
You can open a target data list entry using the native application with which it was created by
right-clicking on the item and selecting Open File in the context menu. If the native application for
the item is not available on your computer, a window appears where you can select the
application to view the item data. If you want to view the metadata of an item that can be
opened with the native application, right-click and select Open Item. For more information, see
"Opening Items" on page 30.
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Figure 1-8: Open Item metadata
Note: Not all the data about an item appears in the list.

Icons in the Source and Target Panes
In the Source and Target panes, the root nodes, sites, lists, and folders have individualized icons.
Any list type without an assigned icon uses a default icon

.

Note: Not all lists for a site are shown in the list. If certain lists contain system information, they may
not be shown.
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Figure 1-9: Sample icons with descriptions below
Icon

Description
Sources contains one or more source data stores. You can select the sources root node as your
search source.
Targets contains the target Microsoft Office SharePoint Server databases for connection as a
target.
Source Root Node contains the .mdf, .ndf, and .ldf files. Click the plus sign (+) next to a node to
expand its contents.
Target Root Node contains the target server. Click the plus sign (+) next to a node to expand its
contents.
Site contains the site/site collection nodes lists. Click the plus sign (+) next to a node to expand its
contents.
Default icon for List objects, custom lists, and Datasheet
Document Library, Form Library, Wiki Page Library are Web Parts that organize documents
by department, project, or by topic.
Folders can be created within Web Parts to organize documents or lists.
Discussion Board can contain Web discussion notes between users of the site.
Agenda can contain information that meeting attendees need to have access to in advance of a
meeting.
Calendar is a view of the events list after recurring events have been added.
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Icon

Description
Text Box can be created within a Web Part to just contain text.
Surveys can contain various forms of surveys: online surveys, email-based surveys, and
database-driven surveys.
Contacts, Attendees are lists that contain contacts for the users of the site including phone
numbers, email addresses, and other information.
Picture Library, Report Library are Web Parts similar to Document Libraries which store
documents and allow users to attach metadata to the documents.
Data Connection Libraries are Web Parts similar to Document Libraries which store documents
and allow users to attach metadata to the documents.
Slide Libraries are Web Parts similar to Document Libraries which store documents and allow
users to attach metadata to the documents.
Translation Library, Languages, and Translators are the list of languages to assign to
translation tasks and any translators specified for each language.
Announcements is a Web Part in SharePoint and contains any announcements entered by a
Site Administrator.
Links is a Lists Web Part that provides easy access to websites.
Tasks is a Lists Web Part used for managing tasks within a project.
Project Tasks, Issue Tracking are used to track issues based on different categories added by
the Site Administrator.
Decisions is a list created from a template within a Meeting Site in SharePoint.
Things to Bring contains lists in the Lists Web Part.
Datasheet is a view within a library or list that requires Microsoft Excel to open.
KPI List contains Key Performance Indicator lists in the Lists Web Part.
(This is appears as Status List in Microsoft Office SharePoint 2010).
Circulations contains lists that track to track the flow of documents in a Group Work list
(Microsoft Office SharePoint 2010 only).
IME Dictionary List contains data used in a list as a Microsoft Input Method Editor (IME)
dictionary (Microsoft Office SharePoint 2010 only).

Changing the Appearance of Main Window
You can change the view in the Ontrack PowerControls window by hiding the toolbar or status
bar, adjusting split bars; sorting lists; and refreshing the screen.
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Viewing or Hiding the Toolbar and Status Bar
The toolbar and status bar appear by default in the main window, but you can easily hide them.
To hide the toolbar or status bar
n

On the View menu, select Toolbar or Status Bar. The check mark no longer appears next to
the name of the toolbar or status bar.

To view the toolbar or status bar
n

On the View menu, select Toolbar or Status Bar. The check mark appears next to the name
of the toolbar or status bar.

Resizing Panes Separated by a Split Bar
You can use a split bar (the horizontal or vertical double line that separates two panes) to increase
the area within one pane while simultaneously decreasing the area within the adjacent pane.
To resize panes separated by a split bar
1. Position the pointer over a split bar between the two panes on either the vertical or
horizontal split bar.

Figure 1-10: Arrange Columns context menu
2. When the pointer becomes a double-headed arrow, drag it to resize the pane.
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Arranging Columns in the Items List
You can arrange the columns in the Source and Target Items list by dragging the column headers.
You can add or remove columns by right-clicking on the column header to view the Arrange
Columns context menu.

Figure 1-11: Arrange Columns context menu
Selecting Arrange Columns opens the Arrange Columns dialog box.

Figure 1-12: Arrange Columns dialog box
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To arrange columns horizontally
1. Select one or more items in the Available list and click Include>. The item(s) appear at the
bottom of the Current list.
2. To include all of the Available list items in the Current list, click Include All>>.
3. To exclude all of the Current list items in the Available list, click <<Exclude All.
4. To set the lists to the default setting, click Reset.
5. Click OK.
Note: At least one column must remain in the Current list to exit from the Arrange Columns
window.
Note: You can display up to eight lookup columns on the target.
To arrange columns vertically
1. To arrange the order in the Current list, select one item at a time and click Move Up or Move
Down. The list appears in this order from left to right in the Source or Target list view.
2. To set the lists to the default setting, click Reset.
3. Click OK.

Sorting Items in the Items List
You can sort items in the source and target lists based on any column.
To sort a list
1. Click a column heading to sort the items based on that heading. For most headings, an
arrow appears indicating the sort direction. An up arrow indicates that the items appear in
ascending (A-Z) order. A down arrow indicates that the items appear in descending (Z-A)
order.
2. To reverse the order of the items based on that column heading, click the column heading
again. Notice the arrow reverses directions.
An example of sorting items
n

If you click the attachment
column heading, items are sorted in descending order
based on this heading, even though no arrow appears. This means that items with
attachments appear at the bottom of the list, while items with no attachments appear at
the top of the list. If you click the attachment
reversed.

column heading again, the order is

Note: The view settings (sort order and column width) for a folder or list are saved until you
close the data store.
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Refreshing the Screen
You may want to refresh the screen occasionally when you are connected to a live target server,
as the information on the server may change while you are connected.
To refresh the screen
n

Do one of the following:
l

On the View menu, select Refresh.

l

Press the F5 key.

Viewing the Target in a Browser
You can view any item in the Target pane (other than the root node) in its own browser.
Note: For more information about opening a target, see "Data Wizard: Target Server Selection
Page" on page 22 and "Opening Source or Target Files" on page 27.
To view the target in a browser
1. In the Target pane, select the target you want to view in a browser.
2. Do one of the following:
n

Right-click the target and select Launch in Browser.

n

On the Edit menu, select Launch in Browser.

n

Press Ctrl+B.

The selected target appears opens in your system's default browser.

Viewing the Properties of a Content Database
Ontrack PowerControls makes it easy to view the properties of a content database file.
To view the properties
1. In the Source pane, right-click a content database file.
2. On the shortcut menu, select Properties to view the MDF File Properties dialog box.
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Figure 1-13: MDF File Properties (without Remote Blob Store)

17

Figure 1-14: MDF File Properties (with Remote Blob Store)
You can save the GUID by clicking the Save GUID button and directing the text file to your desired
location.

Setting Preferences
With the Preferences dialog box, you can set the defaults for how Ontrack PowerControls
performs recurrent operations.
To change preference settings
1. On the Edit menu, select Preferences.
2. Select or clear the check boxes, as desired.
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Figure 1-15: The Preferences dialog box
n

Run Data Wizard on startup: When this option is selected, the Data Wizard starts every time
you open Ontrack PowerControls.

n

Show warning when no log files specified: When this option is selected, Ontrack
PowerControls warns you when opening a file if an .ldf file path has not been specified.

n

Check for duplicates during copy: When this option is selected, two forms of duplicate
checking will occur depending on the type of item that is being copied. In either method, if
an item is a duplicate and you choose to overwrite, the existing item is removed and the
new item is added. For more information, see "Duplicate Checking" on page 51.

n

Automatically connect to ACTS: When this option is selected, Ontrack PowerControls will
automatically attempt to connect to the Agent for Content Transfer Service when you click
Next on the Data Wizard: Target Server Selection Page.

19

Chapter 2: Using Ontrack PowerControls
Overview
You can open a source MDF file or NDF file and specify a target Microsoft Office SharePoint Server
using the Data Wizard. You can also open the source database and target server from the main
window, as well as open a source database with the command line.
Before You Use Ontrack PowerControls
Use Ontrack PowerControls ExtractWizard if you have not yet restored backed-up data. The
Ontrack PowerControls ExtractWizard reads previous Microsoft Office SharePoint Server backups
and restores files to any machine, volume, or folder. For more information, see the Ontrack
PowerControls ExtractWizard User Guide.

Keyboard Shortcuts
The following table contains keyboard shortcuts for many of the common tasks performed when
using Ontrack PowerControls.
Menu Bar

Keyboard Shortcut

File Menu
Open Source

Ctrl+S

Open Target

Ctrl+T

Open Item

Ctrl+O

Close Store

Ctrl+L

Use Wizard

Ctrl+W

Exit

Alt+F4

Edit Menu
Copy

Ctrl+C

Paste

Ctrl+V

Select All

Ctrl+A

Launch in Browser

Ctrl+B

View Menu
Refresh Screen

F5

Tools Menu
Export

Ctrl+P

Find

F3

Help Menu
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Menu Bar
View Help Contents

Keyboard Shortcut
F1

Opening the Source Database and Target
Servers with the Data Wizard
The Data Wizard guides you through the loading of the MDF, NDF, and LDF files into Ontrack
PowerControls and shows you how to specify the target server.

Opening the Data Wizard
The first time you start Ontrack PowerControls, the Data Wizard opens at the Source Path Selection
page.
When working in the main window, you can return to the Data Wizard at any time.
To manually start the Data Wizard
n

On the File menu, select Use Wizard.

Data Wizard: Source Path Selection Page
Use the Source Path Selection page of the Data Wizard to specify the source MDF, LDF, and NDF
file paths and the temporary file path.
Note:
n

If you do not want to open a source MDF, NDF, and LDF file at this time, click Skip.

n

If you do not want to run the Data Wizard every time you start Ontrack PowerControls, clear
the Show wizard on startup check box.

To specify a source file
1. In the Source Files group, do one of the following:
n

Click Add and use the Open dialog box to find the source .mdf file, .ndf file, and .ldf
files.

n

Open Windows Explorer and drag the source files from their location onto the Source
Files box.

Important: Verify that the log files and database files were created in the same backup.
Important: If your source content database contains an NDF file, it must be included with
the MDF file.
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Note: Multiple files can be added to the Source Files box and are listed in the order they
were added, however, only a single content database can be opened.
Note: If you want to remove files from the Source Files box, select the file and click Remove.
Note: When opening Transparent Data Encryption databases, after clicking Finish an "Add
Transparent Data Encryption Database requirements" dialog box appears. Add a path to
Transparent Data Encryption database key and provide Transparent Data Encryption key
password.
2. In the Temporary File Path box, accept the default location for the .idx and .dat files or, if the
files require more hard drive space, specify a new location by clicking Browse (...).

Figure 2-1: Temporary File Path selection
3. Click Next. The Target Server Selection page appears.

Data Wizard: Target Server Selection Page
Use the Target Server Selection page of the Data Wizard to enter the information to connect to the
server running Microsoft Office SharePoint Server you are using as the target for your restored data.
If you do not want to select a target at this time, click Skip.
To specify a server running Microsoft Office SharePoint Server as the target for restored data
1. In the SharePoint Server Site URL box, do one of the following:
n

Enter the URL of the server running Microsoft Office SharePoint Server you are using as
the target.

n

Use the drop-down arrow to select a previously used target.

2. In the Authentication Information group, select one of the following:
n

Connect using the current Windows credentials to use Windows credentials of the
currently logged-in user to access the web service.

n

Connect as a different Windows user, then enter the Username, Password, and
Domain of that Windows user.
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n

Connect using Forms Authentication, then enter the form credentials Username and
Password.

3. Click Next.

Data Wizard: Agent for Content Transfer Service (ACTS)
Selection page
Use the Agent for Content Transfer Service (ACTS) page of the Data Wizard to enter the
information to connect to the server running Microsoft Office SharePoint Server you are using as
the target for your restored data. If you do not want to select a target at this time, click Skip.
To specify a server running Microsoft Office SharePoint Server as the target for restored data
1. In the Agent for Content Transfer Service Port Number box, enter a valid port number to use
ACTS.
2. In the Authentication Information group, select one of the following:
n

Connect using the current Windows credentials to use the credentials for Windows
user currently logged in.

n

Connect as a different Windows user, then enter the Username, Password, and
Domain of that Windows user.

3. If a User Principal Name is required for Kerberos authentication, select User Principal Name
(UPN) required for Kerberos authentication to enable the UPN box and enter the user name
of the account running the ACTS on the server (example format: user@domain.local).
4. Click Finish.

Remote Blob Store Configuration (FILESTREAM Provider)
When you attempt to open a source, Ontrack PowerControls checks if Remote Blob Store (RBS) is
enabled and if FILESTREAM is in use. If both are true, the Remote Blob Store Configuration dialog
box appears, prompting you to select the RBS FILESTREAM files (filestream.hdr).
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To select the RBS FILESTREAM configuration files
1. On the Remote Blob Store Configuration dialog box, click Add.

Figure 2-2: Remote Blob Store dialog box with FILESTREAM provider.
2. Use the Choose configuration file dialog box to select the RBS FILESTREAM files
(filestream.hdr) for this database.
3. If you are using multiple providers, click Next on the Remote Blob Store Configuration dialog
box and configure additional providers.
Note: You can remove a filestream.hdr from the Files box by clicking Remove.
4. Click Finish.

Remote Blob Store Configuration (Metalogix StoragePoint
Provider)
When you attempt to open a source, Ontrack PowerControls checks if Remote Blob Store (RBS) is
enabled and if Metalogix StoragePoint is in use. If both are true, the Remote Blob Store
Configuration dialog box appears, prompting you to select the Metalogix StoragePoint server URL.

Note about the licensing agent: The "Agent for Metalogix StoragePoint" must be enabled in order
to restore data from an RBS provider. For more information, see "Enabling the Licensed Agents" in
the Readme File.
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To configure the Metalogix StoragePoint server URL
1. On the Remote Blob Store Configuration dialog box, click Add.
2. In the Metalogix StoragePoint server URL box, do one of the following:
n

Enter the URL of the server that is running Metalogix StoragePoint.

n

Use the drop-down arrow to select a previously used target.

Figure 2-3: Remote Blob Store dialog box with Metalogix StoragePoint provider
3. Select one of the following:
n

Connect using the current Windows credentials to use Windows credentials of the
currently logged-in user to access the URL.

n

Connect as a different Windows user to enter different Windows credentials than the
currently logged-in user, then enter the Username, Password, and Domain of that
Windows user.

n

Connect using Forms Authentication, then enter the form credentials Username and
Password.

4. Click Finish.

Remote Blob Store Configuration (StorSimple SharePoint
Database Optimizer)
When you attempt to open a source, Ontrack PowerControls checks if Remote Blob Store (RBS) is
enabled and if StorSimple SharePoint Database Optimizer is in use. If both are true, the Remote
Blob Store Configuration dialog box appears.
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With the Remote Blob Store Configuration dialog box, you can verify the UNC path(s) that
references the root location(s) of the StorSimple SharePoint Database Optimizer RBS Blob store
data or substitute for another path(s) (as may be the case if the original blob store is no longer
available or has been significantly altered since the content database backup).
Note about the licensing agent: The "Agent for StorSimple SharePoint Database Optimizer" must
be enabled in order to restore data from an RBS provider. For more information, see "Enabling the
Licensed Agents" in the Readme File.
To configure the StorSimple SharePoint Database Optimizer
1. On the Remote Blob Store Configuration dialog box, do one of the following:
n

Review and accept the Original Path(s) used by the content database and continue
to open this source.

n

If you want to update the Active Path for Blob Store Path 1 or Blob Store Path 2, click its
Browse button and use the Browse for Folder dialog box to select the location of the
StorSimple SharePoint Database Optimizer RBS Blob store data for the database.

Figure 2-4: Remote Blob Store dialog box with StorSimple SharePoint Database Optimizer
provider
2. Click Finish.
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Results of Data Wizard
When you complete the Data Wizard, the Source panes in the main window display a source
content database (which contains an MDF file, 1 or more LDF files, and 0 or more NDF files) and the
Target panes display a target server.
Important: If your source content database contains an NDF file, it must be included with the MDF
file.

Figure 2-5: Source panes with a source content database

Figure 2-6: Target panes with a target server

Opening the Source Database and Target
Servers from the Main Window
Instead of running the entire Data Wizard, you can access the Source Path Select page or the
Target Server Selection page from the main window.

Opening Source or Target Files
You can access the Source Path Select page to open the source databases or the Target Server
Selection page to open target servers from the main window. These two pages are identical to
those on the Data Wizard, with the Next button replaced with a Finish button.
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To open a source file
1. Do one of the following:
n

On the File menu, select Open Source.

n

On the toolbar, click the Open Source icon

n

Press Ctrl+S

n

Drag a single MDF file into the source tree pane of the main window.

.

2. Complete the Source Path Selection page.
3. For information about how to complete the Source Path Selection page, see "Data Wizard:
Source Path Selection Page" on page 21.
4. Click Finish.
Depending on your configurations, you may need to complete the Remote Blob Store
Configuration dialog box. For more information, see "Remote Blob Store Configuration
(FILESTREAM Provider)" on page 23.
To open a target
1. Do one of the following:
n

On the File menu, select Open Target.

n

On the toolbar, click the Open Target icon

n

Press Ctrl+T

.

2. Complete the Target Path Selection page.
For information about how to complete the Target Path Selection page, see "Data Wizard:
Target Server Selection Page" on page 22.
3. Click Finish.

Opening the Source Database from the
Command Line
In addition to using the Data Wizard or main window, a third method to open the source
databases is with the command line.
To open the source database with the command line
1. Open the command line.
2. Type the location of the Ontrack PowerControls installation files, followed by
PC.SharePoint.exe.
3. Append this with the temporary file path and/or the source file names as parameters.
n

Every source file name must be prefixed with the keyword -sourcefile and enclosed
within double quotes. The prefix and the file name must be separated with a space.
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n

The temporary file path must be prefixed with -t keyword and enclosed within double
quotes. The prefix and the temporary file path name must be separated with a
space.

n

If the database uses RBS FILESTREAM, specify the location of the .hdr files prefixed with
-rbsfilestream and enclosed within double quotes. The prefix and the file path name
must be separated with a space.

n

If the database uses StorSimple RBS, specify the original path and the alternate
location of the RBS store prefixed with -rbsStorSimple, enclosed within double quotes,
and separated by an equal sign. Each pair of path names (original path=alternate
location) must have its own -rbsStorSimple prefix and be separated with a space.

n

To automatically open the specified source database and view it in the source tree
view, type -a. (Does not apply if either RBS parameter is provided.)

4. Press Enter.
n

If the "Show wizard on startup" box is selected on the Data Wizard, Ontrack
PowerControls opens the Data Wizard. The command line content will appear on the
Source Path Selection page.

n

If the "Show wizard on startup" box is cleared on the Data Wizard, Ontrack
PowerControls opens the Data Wizard at the Source Path Selection page with the
command line content displayed.
Note: In both cases, information entered from the command line appears on the
Source Path Selection page.

n

If the -rbsfilestream prefix is used, the specified files will appear in the Remote Blob
Store Configuration dialog box during the source open process.

n

If the -rbsStorSimple prefix is used, the specified path(s) will be changed and appear
in the Remote Blob Store Configuration dialog box during the source open process.

Note: For more information, see:
n

"Remote Blob Store Configuration (FILESTREAM Provider)" on page 23

n

"Remote Blob Store Configuration (Metalogix StoragePoint Provider)" on page 24

n

"Remote Blob Store Configuration (StorSimple SharePoint Database Optimizer)" on page 25.

Opening Multiple Sources and Targets
You can display multiple sources in the Source pane and multiple targets in the Target pane. See
the instructions for using the Data Wizard or the main window to open one source or one target at
a time.
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Multiple Sources

Multiple Targets

Figure 2-7: Multiple sources can be displayed

Opening Items
You can view an item's metadata from the source list, target list, search results, or the Previous
Versions window. You can then open the file directly from the metadata window if that file is
available (for example, items in a document library) and the native application of the file is
installed on your computer. Attachments can also be viewed with the native application of the
file.
You can also open a file directly from the main window without going through the metadata
window. Only one item can be opened from the list at a time.
Note: You can view the metadata of any type of item in the list. However, not every item can be
opened because of the type of item, the availability of the file itself (for example, items in a
document library), or the availability of the native application on your computer.
Note: Temporary files are created when file items are opened and then are cleaned out when
Ontrack PowerControls is exited. However, any files still open in their native application when you
exit are not cleaned out. If this temporary location ever becomes full, you will not be able to open
items.

To open an item's metadata
n

In the Source or Target list, right-click an item and select Open Item, or highlight and select
Open Item from the File menu. The item's metadata appears.
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Figure 2-8: Metadata for an item
l

The title of the window is the leaf name and the version number of the item.

l

The path to the file appears below the menu bar.

l

In source items, the File menu provides options to open or save attachments or
open the file.

l

The Tools menu, available only in source files, provides the option to view any
previous versions of the file.

l

In target items, the menu bar provides options to open or save attachments, or
open the file.

Opening the File
After viewing the item's metadata, you can open the file directly from the Open Item metadata
window if the Open File option is enabled. You can also open it from the main window.
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To open the file
n

Do one of the following:
l

In the Source or Target list, right-click the item and select Open File, or highlight the item
and select Open File from the File menu.

l

In the Open Item metadata window, select the File menu and select Open File.

Note: Files cannot be opened without the native application of the file being installed on
your computer.
Note: If the file is a ghost document and not the actual document in your site, it may not be
available to open.

Saving Attachments
A save attachments option is available on the File menu and the Attachments submenu of an
open item. The Save Attachments dialog box lists the attachments for the selected item and lets
you select the attachments you want to save.
To save attachments in an open item
1. In the list item with a paperclip icon, do one of the following:
n

On the File menu, select Save Attachments.

n

Right-click the item and select Save Attachments in the context menu.

2. In the Save Attachments dialog box, select one or more attachments.

Figure 2-9: Save Attachments dialog box
3. To Save To a different location, click Browse (...).
4. In the Browse For Folder window, select a location for the attachment(s), and click OK.
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5. Click OK in the Save Attachments dialog box.

Previous Versions in Source
You can open all previous versions of a source list item one at a time. These list items can be
opened, copied, or exported, and the attachments can be saved.
To open previous versions of a list item
1. Do one of the following:
n

Highlight the list item, select the Tools menu, and select Previous Versions.

n

Highlight the list item, right-click and select Previous Versions.

2. In the Previous Versions window, open the item's metadata, open file, copy, or export any
item by using the menu or right-clicking the item. Save Attachments is enabled on items
containing an attachment.

Figure 2-10: Previous versions of a source item
Note:
n

See "Restoring Microsoft Office SharePoint Server Data" on page 47 for exporting
instructions.

n

See "Saving Attachments" on page 42 for instructions on saving attachments.

n

See "Restoring Microsoft Office SharePoint Server Data" on page 47 for copying instructions.

n

SharePoint only stores the attachments of the most recent version of an item. If an
attachment of a previous version is removed, it will not be shown in the Previous Versions
dialog.

Closing Sources and Targets
You can close sources and targets from the main window.
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To close a source
1. In the Source pane, select a source content database file.
2. Do one of the following:
l

On the File menu, select Close Store.

l

Right-click the selection, and on the context menu, click Close Store.

l

Press Ctrl+L

To close all stores
n

Do one of the following:
l

In the Source or Target pane, right-click the root node, and click Close All Stores.

l

On the File menu, select Close All Stores.

To close a target
1. In the Target pane, select target server file.
2. Do one of the following:
l

On the File menu, select Close Store.

l

Right-click the selection, and on the context menu, click Close Store

l

Press Ctrl+L
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Chapter 3: Searching on Microsoft Office
SharePoint Sources
Overview
The Find in Sources window enables you to search source content databases for items that are
defined by such criteria as keywords, creators and modifiers, and item creation and modification
dates. In addition, this window lets you define the scope of your search: in one or more content
databases, sites, lists, folders, or even previous search results.

Guidelines for Using the Find Window
The following guidelines will assist you in your search and analyzing the results.
n

Ontrack PowerControls can search multiple content databases at the same time. In the Find
in Sources window, click Browse and you will see a tree view of all of the open source data
stores. You can then select multiple sites or folders to include in your search.

n

Previous versions of an item are not searched.

n

Only a single search window can be open at a time.

n

The Find Now button only becomes available if at least one of the following conditions is
met:
l

No search is in progress.

l

All items or a specific item type is selected in the Search for item type OR Custom item
types is selected and the custom item type box contains at least one character.

l

The Search for words or Exclude words box contains at least one character.

l

The Created by box contains at least one character.

l

The Modified by box contains at least one character.

l

The Created after or Created before check box is selected.

l

The Modified after or Modified before check box is selected.

n

Each Search in drop-down selection that you select is run as a separate query, and the
results of the query are combined (that is, OR'd together). For example, if you enter "solution"
in the Search for words box, and then select the Item Data and File Data option, Ontrack
PowerControls will return items that contain "solution" in either the item data or file data.

n

If you don't specify the Search for words or Exclude words, all items will be returned as hits
unless other criteria are provided.

Searching Sources
You can use the Find in Sources window to search single or multiple databases and perform
actions on the search results.
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You can open, copy, export items, or save attachments on search results.

Opening the Find in Sources Window
In the source tree view pane, selecting the sources node, source node, site, list, or folder you want
to search enables the Find submenu and the Find icon

in the toolbar. The item(s) you select

defines the scope of your search.
To open the Find in Sources window
1. Select the item you want to search.
2. Do one of the following to open the Find in Sources window:
n

Click Find
in the toolbar. The name of the folder you selected appears next to the
Search in box

n

Right-click the folder and click Find

n

On the Tools menu, select Find

n

Press F3.

Note: The first time you search for an item, the Search in option is automatically selected. For
information on using the Search in results option, see "Searching Within Results" on page 40.

Figure 3-1: The Find in Sources window
3. To search multiple sites, lists, or folders, click Browse (...) next to the Search in path. In the
Select Location(s) window, select the items you want to search.
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Figure 3-2: You can select multiple data stores to search.
Note: If you select the Search Subfolders check box, Ontrack PowerControls includes
subfolders in the search.
4. Click OK to return to the Find in Sources window.
In the following illustration, the Search in box now displays "Multiple locations selected."
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Figure 3-3: Result when multiple items are selected

Selecting the Item Type(s)
The Search for item type drop-down list initially provides two options, All Items and Custom. The
entire list of possible item types can be lengthy. If you want to search all items or enter in your own
custom items, you can bypass this list. However, if you want to select item types from the list, you
can click the Load Item Types button and the entire list populates the Search for item type dropdown list.
To select the item types
n

In the Search for item type box, do one of the following:
l

All Items: Leave All Items as the default if you want to search all items in the Microsoft
Office SharePoint Server source, OR

l

Custom: Select Custom in the drop-down list to manually enter item types in the Custom
item types box you want to be searched, separated by a comma, OR

l

Load Item Types button: If you have used the Load Item Types button, the list will contain
all of the item types present in the source databases. You can select the specific type
for which you are searching.

Note: If another source is searched and the Load Item Types button is clicked, those item
types are added to the drop-down list.
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Narrowing the Scope of the Search
You can narrow down the scope of your search by entering keywords to search for and enter any
keywords that should be excluded. You can select what type of data to search in: Item Data; Item
Data and File Data; or Item Data, File Data, and Attachments.
To narrow the search down further, you can enter the person who created the item and/or the
person who modified it at some point. You also have the option of searching within a certain
range of dates.
To narrow search results
1. In the Search for words box, enter one or more words or phrases if you want to execute a
keyword search. Keep in mind the following points:
n

Put a space between words or phrases to perform an AND operation (that is, all words
must be matched in order to include an item with the search results).

n

Put a comma between words or phrases to perform an OR operation (that is, only one
of the words must be matched in order to include an item with the search results).

n

Put quotation marks around word phrases (that is, the exact phrase must be matched
in order to include an item with the search results).
Example:
Search for words: dog cat mouse, rat
Search results: Items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"] are
included in the search results.

2. In the Exclude words box, enter words or phrases if you want to perform a NOT operation. If
matched, these words or phrases will exclude the item from the search results. The rules for
using spaces, commas, and quotation marks apply when excluding words from a search.
Example:
Search for words: dog cat mouse, rat
Exclude words: bird
Search results: Items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"] BUT NOT
["bird"] are included in the search results.
3. In the Search in box, select one of the following from the drop-down list: Item Data; Item
Data and File Data; or Item Data, File Data, and Attachments.
Note about searching within file data or attachments: Ontrack PowerControls does
not search within archive file types such as .zip or .rar files. For more information, see
"Searching Within File Data or Attachments" on page 43.
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4. In the Created by and Modified by boxes, enter the appropriate names, if desired. The rules
for using spaces, commas, and quotation marks apply when using the Created by and
Modified by boxes.
5. For Created after and Created before or Modified before and Modified before, select the
appropriate check box, if desired. You may select both check boxes. Then type or select
the part of the date you want to change.
n

Created after: Searches for items created on or after the selected date.

n

Created before: Searches for items created on or before the selected date.

n

Modified after: Searches for items modified on or after the selected date.

n

Modified before: Searches for items modified on or before the selected date.

6. When you have finished specifying the search criteria, click Find Now. The results of your
search appear in the item list.

Figure 3-4: Find in Sources window with results

Searching Within Results
The Search in results option lets you refine the search process using the previous search results.
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To search within results
1. To make the Search in results option available, you must perform at least one search.
2. Modify the search criteria as desired. For information on specifying search criteria, see
"Searching Sources" on page 35.
3. Select the Search in results option at the top left of the Find in Sources window.
4. Click Find Now. The results of your new search appear in the item list.

Using the Find Results
Using the Find results shortcut menu, you can:
n

Open an item's metadata

n

Open the file in the Search Results

n

Copy and paste content

n

Export an item

n

Save attachments

n

View previous versions of an item

Opening an Item's Metadata
You can open the metadata of an item in the search results by right-clicking the item and
selecting Open Item or selecting the item and selecting Open Item from the File menu. Only one
item at a time can be opened from the list.
For more information, see "Opening Items" on page 30.

Opening the File in the Search Results
If the item is available (that is, items in a document library) and has an associated application on
your computer, the Open File option is available in the context menu or the menu bar. If the item
does not have an associated application, (for example, contact, announcement, calendar, and
so on), the Open File option is not available.
You can also open the file from the Open Item metadata window. For more information, see
"Opening the File" on page 31.

Copying and Pasting Content
You can copy content from the search results list and paste them into a target. To copy and paste
the whole list, under the Edit menu, select Select All or right-click the list and select Select All, then
Copy.
For more information, see "Restoring Microsoft Office SharePoint Server Data" on page 47.
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Exporting an Item
With the Export feature, you can copy individual or multiple items from the Find in Sources window
to a local or network drive destination.
For more information, see "Exporting Microsoft Office SharePoint Server Data" on page 44.

Saving Attachments
You can save any attachment of items that appear in the search results to the destination of your
choice.

Previous Versions
By right-clicking a find result item, the context menu has Previous Versions enabled if that item has
previous versions associated with it. If Previous Versions is disabled, there are no previous versions of
that item. This option is also available in the Tools menu.

Figure 3-5: Previous versions of the item
When copying items, previous versions of the item are also copied.
For more information, see "Previous Versions in Source" on page 33.

Viewing Previous Search Results
You can click the Previous button multiple times to return to any previous search criteria and
search results. This button becomes unavailable when there are no more previous results.
To view previous search results
1. Perform at least two searches so the Previous button becomes available.
2. Click Previous. The results of the previous search appear in the item list.
3. You can now view the previous search, or you can modify the search criteria and conduct
a new search. For information on specifying search criteria, see "Searching Sources" on
page 35.
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Clearing Fields and Results
If you click the Clear Fields button, all of the search criteria that you entered in the Find in Sources
window are returned to the default settings. If you click the Clear Results button, all current and
past search results are cleared.

Searching Within File Data or Attachments
In the Find in Sources window, you can search the text of file data or attachments. The searching
within a file or attachments feature supports Unicode text and is available for MDF, NDF, and LDF
sources. Ontrack PowerControls supports Microsoft® Office documents and many other file types.
For a list of supported file types, see the FAQs at
www.ontrackpowercontrols.com/support/product-support/.
Note about the licensing agent: The "Agent for Advanced Searching for SharePoint" must be
enabled in order to search file data or attachments. For more information, see "Enabling the
Licensed Agents" in the Readme File.
To search within files and/or attachments
1. In the Find in Sources window, select Item Data and File Data or Item Data, File Data, and
Attachments from the Search in drop-down list.
2. Specify other desired search criteria. For more information, see "Searching Sources" on
page 35.
3. Click Find Now. If Ontrack PowerControls matches a keyword or phrase in the text of the file
or attachment, it will return a "Hit" just as it would if it found a keyword or phrase in the
metadata of an item.

Exceptions When Searching Within File Data or Attachments
Ontrack PowerControls does not search for the following items:
n

Archive files (for example, .zip, .rar)

n

Binary files (for example, .dll, .exe, .jpg)

n

Metadata associated with files (for example, author and company information in an .xls file)

Restoring Items from the Find in Sources
Window
The results of conducting a search appear in the item list in the Find in Sources window. You can
restore the items in this list by dragging them or copying and pasting them into the target folder.
You can also restore items by browsing in the main window and dragging or copying and pasting
from the main window to the target. You do not need to search to restore items. For more
information, see "Restoring Microsoft Office SharePoint Server Data" on page 47.
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Chapter 4: Exporting Microsoft Office
SharePoint Server Data
Overview
You can export data from a content source file to a local or network drive destination.

Guidelines for Exporting Items
The following guidelines will assist you in exporting items.
n

The file name for an exported item is its leaf name. A duplicate leaf name creates a file with
the same name but with an (x) appended to the filename: x = 1 for the first duplicate, x = 2 for
the next duplicate, and so on.

n

You must have access rights to the target location of the exported item.

n

Single or multiple items can be exported from the list view

n

Single or multiple items can be exported from the tree view.

n

Sub-items can be exported if the export is initiated from the tree view. This includes sites, lists,
or folders underneath the selected tree node.

n

You have the option to maintain the path to the item when the export is initiated from the list
view. This creates a path including all the sites, lists, and folders up to and including the item
name.

n

When exporting a site, list, or folder from the tree view, a file system folder will be created
based on the node name.

n

Previous versions are exported to a subfolder named "document name" and "_Revisions"
(example: "Document_Revisions"). Previous version file names are "document name" and "_
Revision Number"(example: "Document_1.1").

n

If the same item is exported twice to the same location, a number is appended to the title to
give it a unique name. For example, if Sample File.doc is exported to c:\export path\ and
another file with the same name already exists, it is exported as c:\export path\Sample File
(1).doc.

Exporting List Items
The following instructions show you how to export a list item or multiple items from the Source pane
in the main window to a designated location. Items can be exported at a site, list, or folder level.
To export a list item
1. In the Source Message list, select the list item(s).
2. Do one of the following to start the Export Wizard:
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n
n

On the Tools menu, select Export.
On the toolbar, click the Export icon

.

n

Right-click the item, and on the shortcut menu, click Export.

n

Enter Ctrl+P.

3. In the Export To box, specify the location for the exported file.
4. To maintain the message path(s) of the exported list item(s), leave the default setting of the
selected Maintain item path check box. Clear the check box if maintaining the message
path is not desired.
Note: This option creates the path of all the sites, lists, and folders up to and including the
item name.
5. Choose the version to be exported from the following:
n

Current version

n

Previous versions

n

All versions

6. Click Finish. The Export Progress window appears.
Note: Attachments of items cannot be exported. To retrieve attachments, use the Save
Attachments option.
To export a site
1. In the Source pane, select the site.
2. Do one of the following to start the Export Wizard:
n
n

On the Tools menu, select Export.
On the toolbar, click the Export icon

.

n

Right-click the site or list, and on the shortcut menu, click Export.

n

Enter Ctrl+P.

Note: The topmost node of the Export Wizard is selected. If the site you are exporting
contains more than one level of child nodes and items, only the first level appears in this list
and can be exported.
3. In the Choose Export Items pane, select the node(s) to be exported. The following options
are available:
n

Leave every check box selected and export everything. Selecting the topmost node
check box automatically selects all child nodes.

n

Clear the child node check boxes using the Clear All button and export selected
items only.

n

Select the Choose All button to select all items in the tree.

4. Leave the Export sub-nodes check box selected if you want them exported as well or clear
it to exclude them.
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Note: If the topmost node is selected under "Choose Export Items" and "Export
sub-nodes" is selected, all child nodes (and their sub-nodes) will be exported regardless of
their selection status
5. Click Next. The second page of the Export Wizard appears.
6. Select the Export To destination.
7. Choose the version to be exported from the following:
n

Current version

n

Previous versions

n

All versions

8. Click Finish. The Export Progress report appears.
To export a list or folder
1. In the Source pane, select the list or folder.
2. Do one of the following to start the Export Wizard:
n
n

On the Tools menu, select Export.
On the toolbar, click the Export icon

.

n

Right-click the item, and on the shortcut menu, click Export.

n

Enter Ctrl+P.

If the list or folder selected for export contains sub-items, the first page of the Export Wizard
appears.
If the list or folder selected does not contain any sub-items, the second page of the Export
Wizard appears.
3. Select the Export To destination.
4. Choose the version to be exported from the following:
n

Current version

n

Previous versions

n

All versions

5. Click Finish. The Export Progress report appears. This report can be printed or saved to your
local hard drive.
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Chapter 5: Restoring Microsoft Office
SharePoint Server Data
Overview
This section describes how to restore your content (items, lists, folders, and sites) to a live Microsoft
Office SharePoint Server and provides guidelines and important notes for restoring each type of
data to its desired destination.
Items can be restored from multiple locations: the tree view list and folder, the source list, the
Previous Versions window, and the Find in Sources search results list.

General Guidelines for Restoring Microsoft
Office SharePoint Server Data
The following guidelines will assist you in restoring Microsoft Office SharePoint Server data. For
instructions to restore each type of data, see the following:
n

"Restoring Items " on page 53

n

"Restoring a Folder" on page 53

n

"Restoring a List " on page 54

n

"Restoring a Site" on page 55

General Guidelines
n

Items can be restored to lists or folders.

n

Folders can be restored to lists or folders.

n

Lists can be restored to sites.

n

Sites can be restored to sites or site collections.

n

Site collections can be restored as new sites or site collections.

n

When restoring data to a domain other than the original domain, the author/editor
information is inherited from the parent.

n

Source data can be copied to a target running the same or newer version or experience of
Microsoft Office SharePoint Server.

n

Before restoring documents with multiple versions, use the Library (or List) settings to enable
versioning on the target before restoring the documents if you want the version history to be
retained.

n

During any data restore, the target location's parent site collection is checked for any write
locks that are selected. To restore data to any location within the site collection, the "Adding
content prevented," "Read-only," or "No access" must be cleared. These locks can be set
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with the Microsoft Office SharePoint Server Central Administration (Application
Management > Site Collection Quotas and Locks).
n

To restore a folder to a list, set the "Make 'New Folder' command available" option to Yes in
the Library (or List) Settings > Advanced settings for that list.

n

To restore the approval status of an item or folder, set the Content Approval to Yes in the
Library (or List) Settings > Versioning setting for that list.

n

Record Routing lists have been deprecated from Microsoft Office SharePoint Server 2010 or
later. When restoring a Records Center site that contains a Record Routing list to Microsoft
Office SharePoint Server 2010 or later, create Content Organizer Rules to replicate the
behavior of the Record Routing items.

Exceptions
n

The following are not restored during a copy:
l

Alerts

l

Checked out status of an item

l

Legal hold status of an item

n

Blogs, comments, and posts may no longer be linked when restored as items.

n

Holds and Hold Reports lists are not displayed after restoring.

n

If the user does not exist in the target (for example, restoring across domains), the
author/editor information is inherited from the parent.

n

A FastSearchCenter site cannot be restored to a Microsoft Office SharePoint Server 2013
experience.

n

Managed metadata columns are not supported.

n

Microsoft Office SharePoint Server 2013 site collections can be copied to Microsoft Office
SharePoint Server 2013 or later as a new site collection.

n

Microsoft Office SharePoint Server 2016 site collections can be copied to Microsoft Office
SharePoint Server 2016 or later as a new site collection.

n

Only items, lists and folders from Microsoft Office SharePoint Server 2010 updated to
Microsoft Office SharePoint Server 2013 source data can be copied to a Microsoft Office
SharePoint Server 2013 or later target.

Workflow Exceptions
n

Started Workflows are not restored for an item. This includes the history and associated tasks
for the Workflow.

n

Workflows that are set up for a list are not restored. The history and task Lists are restored but
the associations are not automatically setup. Manual setup is possible.

SharePoint WebParts Exceptions
n

Items that contain WebParts, which point to other lists within the site, may not function
correctly if you cancel a site restoring operation before it completes.
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n

All WebParts are restored to the target, but they may not function properly after they have
been restored. Some WebParts store the path and IDs of lists and items they are pointing to.
Since new IDs are generated and enable you to restore data anywhere, the IDs and paths
may no longer be valid after the WebPart is restored.

n

If a WebPart is restored to same target location as the source, most WebParts will function
properly since the paths are the same.

Guidelines for Restoring to Recurring and Non-Recurring
Meeting Workspaces
The following guidelines will assist you in restoring Microsoft Office SharePoint Server data to
recurring and non-recurring meeting workspaces.
Guidelines
n

If restoring items to a non-series library list (for example, Document Library, Slide Library,
Picture Library, and so on):
l

Only meeting instance folders can be restored to the root of the list, and the instance ID
of the meeting instance folder being restored must match one of the instance IDs in the
target meeting workspace.

l

No other folder or item can be restored to the root of the list.

n

If restoring to a non-series list other than a library list (for example, Announcements, Tasks,
Contacts, and so on), the items being copied must match the meeting recurrence criteria
on the target.

n

If restoring to a non-series discussion board:
l

If restoring a discussion topic, the recurrence criteria of the topic must match the target
meeting recurrence criteria.

l

If restoring a discussion item, the item's recurrence criteria must match the recurrence
criteria of the discussion topic on the target.

n

A target list containing series items has the same constraints as any other list (for example,
content type match, checked out state, duplicate items, etc.).

n

When restoring a library list from a recurring meeting workspace into another site that is not a
meeting workspace, the same constraints apply (for example, content type match,
checked out state, duplicate items, etc.).

n

Restoring a list from a recurring meeting workspace to a non-recurring meeting workspace
is not allowed unless the list is a series list.

n

Restoring a list from a non-recurring meeting workspace to a recurring meeting workspace
is not allowed unless the list is a series list.
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Ontrack PowerControls Agent for Content
Transfer Service
The Ontrack PowerControls Agent for Content Transfer Service (ACTS) must be running on the
Microsoft Office SharePoint Server in order to restore content to a specific site. The Ontrack
PowerControls Agent for Content Transfer Service can be started or stopped using the Services
management console or command line.
To start the Ontrack PowerControls Agent for Content Transfer Service with the Services
management console
1. Click Start, then select Run.
2. In the Run dialog box, type services.msc and click OK.
3. In the Services window, do one of the following:
l

Double-click Ontrack PowerControls Agent for Content Transfer. On the General tab of
the Ontrack PowerControls Agent for Content Transfer dialog box, click Start.

l

Right-click Ontrack PowerControls Agent for Content Transfer and select Start.

l

Select Ontrack PowerControls Agent for Content Transfer and click Start in the left
column.

l

Select Ontrack PowerControls Agent for Content Transfer and click Start Service in the
tool bar.

4. Verify that the Ontrack PowerControls Agent for Content Transfer service has started by
refreshing the Services window.
To stop the Ontrack PowerControls Agent for Content Transfer Service with the Services
management console
1. Click Start, then select Run.
2. In the Run dialog box, type services.msc and click OK.
3. In the Services window, do one of the following:
l

Double-click Ontrack PowerControls Agent for Content Transfer. On the General tab of
the Ontrack PowerControls Agent for Content Transfer dialog box, click Stop.

l

Right-click Ontrack PowerControls Agent for Content Transfer and select Stop.

l

Select Ontrack PowerControls Agent for Content Transfer and click Stop in the left
column.

l

Select Ontrack PowerControls Agent for Content Transfer and click Stop Service in the
tool bar.

4. Verify that the Ontrack PowerControls Agent for Content Transfer service has started by
refreshing the Services window.
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To start the Ontrack PowerControls Agent for Content Transfer Service with the command line
1. Click Start, then select Run.
2. In the Run dialog box, type cmd and click OK.
3. In the command line, type net start "Ontrack PowerControls Agent for Content Transfer" and
press Enter.
4. Type net start to view a list of services running and verify that the Ontrack PowerControls
Agent for Content Transfer service is included.
To stop the Ontrack PowerControls Agent for Content Transfer Service with the command line
1. Click Start, then select Run.
2. In the Run dialog box, type cmd and click OK.
3. In the command line, type net stop "Ontrack PowerControls Agent for Content Transfer" and
press Enter.
4. Type net start to view a list of services running and verify that the Ontrack PowerControls
Agent for Content Transfer service is absent.

Duplicate Checking
When copying and pasting Microsoft Office SharePoint Server data, two different types of
duplicate checking are performed:
n

Lists, Folders, and Document Library files: Duplicate checking checks the item's filename or
Leaf Name. If the target list contains an item that has the same name, you are prompted
with the option to overwrite.

n

Items: Items are flagged as duplicates if they are copied from a source that is the backup of
the target and you are attempting to copy the item to the same location.

If a list is copied to another site with the same list, the contents of the source are added to the
target list. The properties of the source list does not overwrite the target list.

Figure 5-1: Leaf Name is used for checking duplicates in Lists, Folders, and Document Library files
If a duplicate is found, an overwrite confirmation message appears.
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Feature Not Found
The Feature Not Found dialog box appears if a feature used by a source site is not found on the
target site; for example, when copying from a previous version of Microsoft Office SharePoint
Server to a more recent version, the feature may longer be available.
If a feature is not found, your options are as follows:
If you want to:

Click
this:

Continue copying the site without the missing feature and be alerted if other missing features
are detected during this copy session.

Yes

Continue copying the site without any missing features.

Yes to
All

Skip the copying of the site and be alerted if another missing feature is found while copying
another site during this copy session.

No

Skip the copying of all sites with missing features during this copy session.

No to
All

Close the Feature Not Found dialog box and end the copy session.

Cancel

Overwrite Confirmation
The Duplicate Item dialog box appears if duplicate items are found during the copy/paste
process and the "Check for duplicates during copy" option is selected on the Preferences dialog
box (Edit menu > Preferences command).
If a duplicate is found, your options are as follows:
If you want to:

Click
this:

Overwrite the duplicate item. Overwriting the items causes the existing duplicate item to be
deleted and the new item copied in its place.

Yes

Overwrite all duplicate items.

Yes to
All

Rename the duplicate item.

Rename

Rename all duplicate items.

Rename
All

Avoid overwriting or renaming the duplicate item. Clicking Skip moves you to the next item
and ignores the overwrite message.

Skip

Avoid overwriting or renaming any duplicate items.

Skip All

Close the Duplicate Item dialog box and end the copy/paste process.

Cancel
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Restoring Your Microsoft Office SharePoint
Server Data
This section provides examples of restoring sites, lists, folders, and items to the desired destination.
In each case, it provides guidelines for restoring data. If you copy a site, list, folder, or item from the
Source pane and paste it to any target destination, Ontrack PowerControls preserves the
directory structure of all restored items. See specific guidelines under each data type being
restored.

Restoring Items
The following instructions show you how to restore individual items to a folder in a target server.
To restore items
1. In the Source pane or Find in Sources window, copy the item from the item list.
2. In the Target pane, paste the items into a folder or list in the target server.
Note: You can also drag an item from the Source pane to the Target pane.
3. In the Copy Progress window, verify that your items were successfully copied. You can also
print or save the copy report by doing one of the following.
n

Click Print to print the copy report.

n

Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window.
Guidelines for Restoring Items
n

You can restore from the items list in the Source pane or the Find in Sources window.

n

Restoring individual items does not preserve the directory structure of the restored items.

n

"Pages" item types may switch their content type when restored; however, metadata is
preserved. In this scenario, the content type becomes the default content type for the list.
For example, the content type on the source would be "Welcome Page," but after restoring,
the content type would be "Page."

n

When restoring an item with moderation status (or approval status) of "Pending", the author
and editor are updated to "System Account."

n

When restoring items to Microsoft Office SharePoint Server 2010 and later, set the Content
Approval to No in the Library (or List) Settings > Versioning setting for that particular list to
avoid loss of version numbers and moderation status changes. Content Approval can be
set to Yes after restoring.

Restoring a Folder
The following instructions show you how to restore a folder to any target destination.
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To restore a folder
1. In the Source pane, copy a folder.
2. In the Target pane, paste the folder into a folder or list.
Note: You can also drag a folder from the Source pane to the Target pane.
3. In the Copy Progress window, verify your results to make sure your items from all folders were
copied to the target destination. You can also print or save the copy report by doing one of
the following.
n

Click Print to print the copy report.

n

Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window.
Guidelines for Restoring a Folder
n

Folders may not have their created and/or modified date preserved when restored.

n

The moderation status (or approval status) of a folder is not retained. The status of a folder
that has been restored is always "Approved."

Restoring a List
The following instructions show you how to restore a list to any target destination.
To restore a list
1. In the Source pane, copy a list.
2. In the Target pane, paste the list into a site.
Note: You can also drag a list in the Source pane to the Target pane.
3. In the Copy Progress window, verify your results to make sure that your lists were copied to
the target destination. You can also print or save the copy report by doing one of the
following.
n

Click Print to print the copy report.

n

Click Save to save the copy report as a text file.

4. In the Copy Progress window, click Close to return to the main window.
Guidelines for Restoring a List
n

When restoring a list that contains a lookup column that includes a field column that
references a list that does not exist on the target:
l

For Microsoft Office SharePoint Server 2013, when browsing to the restored list, a "File Not
Found" error appears. To correct, manually remove the lookup field reference columns
from the restored list.

l

For Microsoft Office SharePoint Server 2016, the lookup field reference column will be
empty.
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Note: When creating or editing a Lookup column, you can include a field column by
selecting any of the "additional fields" columns associated with the lookup.
n

Summary links columns do not function correctly after a list is restored if the target does not
have the Workflows site collection feature activated. Attempting to edit any restored items
displays an XSLT error. To resolved the issue, enable the Workflows site collection feature.
Note: Summary Links columns can only be added to Issue Tracking lists.

n

For Microsoft Office SharePoint Server 2013, restored lists may be added to a site's quick links.

Restoring a Site
The following instructions show you how to restore a site to a target destination.
To restore a site
1. In the Source pane, copy a site.
2. Paste the site into the desired location of the Target pane.
Note: You can also drag a site in the Source pane to the Target pane.
3. If the source site is pasted into the root node of a target, the Select Site Collection URL dialog
box appears. Select the web application and site collection URL and enter the primary site
collection administrator information to copy the site by doing the following:

55

Figure 5-2: Select Site Collection URL dialog box
a. In the Select a Web Application drop-down list, select the web application to be used
as the target server.
b. In URL, view the web application URL label. This is the base URL where the new site
collection will be located
c. In the Managed Path drop-down list, select the managed paths that reside in the target
server for the selected Web Application. The contents of this list changes based on the
Web Application selected. If you want to have a specific URL other than "/site/" for a site
collection, you need to select a managed path.
o

If you select a managed path with Explicit Inclusion, a single Microsoft Office
SharePoint Server site can be created for the given URL, so nothing more is required.
If you select a managed path with Explicit Inclusion, the Site Name field will be
disabled.
Note: This option may not be available if a site has already been created for
the given path.
Example:http://servername:portnumber/Sales
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o

If you select a managed path with Wildcard Inclusion, you can create further site
collections under the specified managed path. The Site Name field is enabled and
you can create the site name which is appended on the path URL. In this case you
must specify a Site Name for the new site collection.
Example:http://servername:portnumber/Manufacturing/Group1 and
http://servername:portnumber/Manufacturing/Group 2.

d. If the Site Name box is enabled, enter a site name for additional website addresses.
Note: The following characters cannot be used in the site name: " # % & * : < > ? \ / { }
~. The site name also cannot start with an underscore character "_".
e. In the Authentication Mode drop-down list, select Windows Authentication or Forms
Authentication.
f. In the Primary Site Collection Administrator box, enter the following depending on the
mode of authentication you are using:
o

If you are using Windows Authentication, enter the domain and username of the
user that will be the primary site collection administrator. This username must be in
the Domain\Username format. Ontrack PowerControls will use this username to
connect to the new site collection after it has been created.

o

If you are using Forms Authentication, enter the username of the user that will be the
primary site collection administrator. Ontrack PowerControls will use this username
to connect to the new site collection after it has been created.

g. In the Password: box, enter the password for the primary site collection administrator.
The username and password are validated for the primary site collection administrator,
so the site collection will not be created until the correct password is supplied for the site
collection administration.
h. Click OK. The source site is copied into the target site.
4. In the Copy Progress window, verify your results to ensure that your sites were copied to the
target destination. You can also print or save the copy report by doing one of the following.
n

Click Print to print the copy report.

n

Click Save to save the copy report as a text file.

5. In the Copy Progress window, click Close to return to the main window.
Guidelines for Restoring a Site
n

Site Quotas for parent-level sites will not be restored.

n

For site and list permissions, if a matching group exists on the target, the site or list will use the
target group's permission levels and users associated with that group. If the target group has
different users or permissions levels than the source, the site or list will now use the target's
permissions .

n

Quick Links for sites that contain a Pages List (Publishing Site, Personalization Site, etc.) may
appear differently after restoring a site. Once a page type document (Page, Article Page,
Master Page, etc.) is checked into a pages site, a Quick Link is added. Since Ontrack
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PowerControls does not restore the checked out state, items are assumed to be checked
in. Therefore, additional Quick Links may appear after the site has been restored.
n

When restoring a site collection from Microsoft Office SharePoint 2007 to Microsoft Office
SharePoint 2013 with the 2010 Experience, the following site collections are blocked:
Enterprise
l

Records Center

l

Site Directory

l

Report Center

l

Search Center with Tabs

l

My Site Host

Publishing

n

l

Collaboration Portal

l

Publishing Portal

When restoring a site with unique master page from Microsoft Office SharePoint 2007 to
Microsoft Office SharePoint 2013 with the 2010 Experience, the default look and feel is
applied. To restore the original master page look and feel, add the master page to the
Master Page Gallery list and change the master page in Site Settings.
Note: The master page should be prepared for Microsoft Office SharePoint Server 2013.
Also, all files referenced in the master page file must exist on the target.

n

Restoring sites to a Microsoft Office SharePoint Server 2013 or later target may produce
duplicate "Site Contents" links in the site's "Current Navigation" pane.

About the Copy Progress Window
Each time you attempt to restore items to the Target pane, the Copy Progress window appears.
This window displays the following information about the copy operation:
n

Source, Source Path, Target, and Target Path

n

Time of copy operation

n

Number of items, lists, folders, and sites

n

Warnings and errors, if any

n

Number of items successfully copied
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Figure 5-3: Copy Progress Window
Note: If you do not have full access rights to the target location, Ontrack PowerControls is unable
to complete the copy process. The target location must also have enough space for the data and
it must support the content type of the source data.

Print Copy Progress Data as a Report
When the copy progress is complete, you have the option to print the report which records any
interruptions in the copy progress or any errors that occurred. This report lists the number of:
n

items that successfully copied

n

items that did not copy

n

errors that occurred

Save Copy Progress Data as a Report
To save the Copy Progress report as a text file to the destination of your choice, click Save.

Configuring the Ontrack PowerControls Agent
for Content Transfer Service to Validate Forms
Authentication Users
When restoring a top level site (site collection), Ontrack PowerControls validates the primary site
collection administrator before restoring the site collection. If the primary site collection
administrator is using Forms Based Authentication (FBA), the Ontrack PowerControls Agent for
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Content Transfer Service (ACTS) must be configured for the FBA provider used by the restored site
collection. The FBA provider is determined by the web application hosting the restored site
collection. The web application is selected in the Create Site Collection URL dialog box. For more
information, see "Restoring a Site" on page 55.
If the primary site collection administrator using Claims Based Authentication, the Ontrack
PowerControls ACTS must be configured for the Claims authentication provider used by the
restored site collection.
To configure the Ontrack PowerControls ACTS to validate site collection users for Forms Based
Authentication (SharePoint 2007 and later)
1. Determine the FBA provider for your web application by doing the following:
a. Open SharePoint Central Administration for your target Microsoft Office SharePoint
server.
o

For Microsoft Office SharePoint Server 2007, do the following:
a. Click the Application Management tab, then in the Application Security group,
click Authentication providers.
b. On the Authentication Providers page, click the Web Application and then click
Change Web Application.
c. In the Select Web Application dialog box, select the web application you want
to use to restore your site collection. The selected application appears in the
Authentication Providers page. The FBA provider name appears in the
Membership Provider Name column. This is the FBA provider.

o

For Microsoft Office SharePoint Server 2010 and later, do the following:
a. On the Central Administration, click Application Management.
b. Under Web Applications, click Manage web applications.
c. On the Web Applications tab, select your web application from the list and click
Authentication Providers on the toolbar.
d. On the Authentication Providers dialog box, in the Zone column, click the zone
you are using.
e. On the Edit Authentication dialog box, scroll down to the selected Enable Forms
Based Authentication (FBA) box in the Claims Authentication Types row. Below is
the ASP.NET Membership provider name box containing the FBA provider.

b. Copy the FBA provider name and use it in the following steps:
2. Locate the FBA provider configuration section for the web application by doing the
following:
The configuration section for the FBA provider may be located in the web.config for the
web application, or it may be inherited from the machine.config.
l

The web.config is located in the IIS virtual directory for the web application (typically at
C:\inetpub\wwwroot\wss\VirtualDirectory\<port number of web application>\).
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l

The machine.config is located in: [WINDOWS
Directory]\Microsoft.NET\Framework\<version>\CONFIG\.

In the appropriate config file, locate the <membership> section under <system.web>.
Under this section, find the <providers> section and locate the provider that matches the
FBA provider name for your web application. It should appear similar to this:
<add name="AspNetSqlMembershipProvider"
type="System.Web.Security.SqlMembershipProvider, System.Web,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a"
connectionStringName="LocalSqlServer" applicationName="/" />
This line must be copied into the ACTS configuration file, as described in the next step.
3. Add the FBA provider and connection string to the ACTS configuration file by doing the
following:
a. Edit the PC.SharePoint.Service.exe.config file, located in the ACTS install folder. This is
typically under [Program Files]\Ontrack\Ontrack PowerControls Agent for Content
Transfer Service.
b. In the config file, add the <system.web> section if it's not already there.
c. Within the <system.web>, add the <membership> section.
d. Within the <membership> section, add the <providers> section.
e. Paste the Forms provider into the <providers> section. The modified config file should
appear similar to the following:
<configuration>
<system.web>
<membership>
<providers>
<add name="aspnetmembershipprovider"
connectionStringName="MySQLServer"
applicationName="MyAppNametype="System.Web.Security.SqlMembe
rshipProvider, System.Web, Version=2.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a" />
</providers>
</membership>
</system.web>
… other sections…
</configuration>
For Microsoft Office SharePoint 2010 and later, you also need to copy the "i" provider section
into the PC.SharePoint.Service.exe.config file and make it the default provider. This provider
goes within the same <providers> section as the FBA provider. To make it the default
provider, add the defaultProvider="i" attribute to the <membership> section as shown
below.
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Note: If you are using multiple membership providers, each membership
provider must have a unique name. Also, make sure the "i" provider only
appears once in the <providers> section of the
PC.SharePoint.Service.exe.config file.
<membership defaultProvider="i">
<providers>
<add name="i"
type="Microsoft.SharePoint.Administration.Claims.SPClaimsAuthMe
mbershipProvider … />
<add name="AspNetSqlMembershipProvider" connection
StringName="MySQLServer" … />
</providers>
</membership>
4. Copy the Connection String configuration section by doing the following:
The connection string used by the FBA provider also needs to be copied from the
web.config (or machine.config) into the PC.SharePoint.Service.exe.config file.
You can find the connection string by looking at the <connectionStrings> section of the
web.config (or machine.config) file and finding the connection string whose name
matches the connectionStringName attribute of the FBA provider. In the example above,
the connection string name is "MySQLServer", so you would locate the "MySQLServer"
connection string and copy that into the PC.SharePoint.Service.exe.config file as described
below.
a. Add the <connectionStrings> section to the PC.SharePoint.Service.exe.config file in the
<configuration> section.
b. Inside the <connectionStrings> section, add the connection string line from the
web.config (or machine.config). When you are finished, the modified
PC.SharePoint.Service.exe.config should look similar to the following:
<configuration>
<connectionStrings>
<add name="MySQLServer" connectionString="Initial
Catalog=aspnetdb_claim;datasource=USEPX1DSQOCB01\OCB01A;
Integrated Security=SSPI;" />
</connectionStrings>
<system.web>
<membership>
… membership providers …
</membership>
</system.web>
… other sections…
</configuration>
5. Save all changes to the PC.SharePoint.Service.exe.config file.
After the ACTS configuration file has been modified, the Ontrack PowerControls Agent for
Content Transfer Service must be restarted before the changes will take effect.
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To configure the Ontrack PowerControls ACTS to validate site collection users for Claims Based
Authentication (SharePoint 2010 and later)
1. Locate the Claims based provider configuration section for the web application by doing
the following:
The configuration section for the Claims provider may be located in the web.config for the
web application, or it may be inherited from the machine.config
l

The web.config is located in the IIS virtual directory for the web application (typically at
C:\inetpub\wwwroot\wss\VirtualDirectory\<port number of web application>\).

l

The machine.config is located in: [WINDOWS
Directory]\Microsoft.NET\Framework\<version>\CONFIG\.

In the appropriate config file, locate the <membership> section under <system.web>.
Under this section, find the <providers> section and locate the provider with the name "i". It
should appear similar to this:
<add name="i"
type="Microsoft.SharePoint.Administration.Claims.SPClaimsAuthMembe
rshipProvider, Microsoft.SharePoint, Version=15.0.0.0,
Culture=neutral, PublicKeyToken=71e9bce111e9429c" />
This line must be copied into the ACTS configuration file, as described in the next step.
2. Add the "i" provider to the ACTS configuration file by doing the following:
a. Edit the PC.SharePoint.Service.exe.config file, located in the ACTS install folder. This is
typically under [Program Files]\Ontrack\Ontrack PowerControls Agent for Content
Transfer Service.
b. In the config file, add the <system.web> section if it's not already there.
c. Within the <system.web>, add the <membership> section.
d. Within the <membership> section, add the <providers> section.
e. Paste the "i" provider into the <providers> section.
f. Set the "i" provider to be the default provider by adding the defaultProvider="i"
attribute to the <membership> section.
g. When you have completed these changes, the modified config file should appear
similar to the following:
<configuration>
<system.web>
<membership>
<providers>
<add name="i"
type="Microsoft.SharePoint.Administration.Claims.SPClaimsAut
hMembershipProvider, Microsoft.SharePoint, Version=15.0.0.0,
Culture=neutral, PublicKeyToken=71e9bce111e9429c" />
</providers>
</membership>
</system.web>
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… other sections…
</configuration>
3. Save all changes to the PC.SharePoint.Service.exe.config file.
After the ACTS configuration file has been modified, the Ontrack PowerControls Agent for
Content Transfer Service must be restarted before the changes will take effect.
To restart the Ontrack PowerControls Agent for Content Transfer Service
1. Click Start, then click Control Panel.
2. On the Control Panel windows, click Administrative Tools.
3. On the Administrative Tools window, click Services.
4. On the Services window, right-click Ontrack PowerControls Agent for Content Transfer and
click Restart.
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Glossary
Term

Description

Data Store

A unified collection of folders, items, and lists contained in a single
storage medium.

Data Wizard

The first time you start Ontrack PowerControls, the Data Wizard
appears. The Data Wizard guides you through the loading of MDF,
NDF, and LDF files into Ontrack PowerControls, and shows you how
to specify the target Microsoft Office SharePoint Server.

Document
Library

A folder where a collection of files is stored and the files often use
the same template.

Duplicate
Checking

A process detecting duplicate items based on filenames which
provides you the option to overwrite the item.

Experience
Level

Often referred to as the "Compatibility Level" or "SharePoint mode,"
this indicates the settings for how Microsoft Office SharePoint
Server presents and interacts with features and content.

Explicit
Inclusions

Selected in Managed Paths, explicit inclusions include only the
specific path that you set. For example, use explicit inclusions if you
want Microsoft Office SharePoint Server to manage a specific path,
such as /portal, but not any possible sites below it, such as
/portal/teamshare.

GUID

Globally Unique Identifier. Each Microsoft Office SharePoint Server
database has a separate GUID.

Item

An entry in a list or folder (posts, pictures, links, comments, etc.)
contained within a list or a folder in the Source or Target panes.

List

A website component that stores and displays information that users
can add to, copy, and search in Ontrack PowerControls.

Log Files

Transaction log files (.ldf files) are history files recording server
activity. These files are useful in restoring and backing up Microsoft
Office SharePoint Server data.

Managed Paths With Managed Paths, you can manage two categories of paths:
included and excluded paths when creating a top-level website or a
specific URL. An included path indicates that it is a Microsoft Office
SharePoint Server-created path. An excluded path indicates that a
different application manages the path and was created by the user.
Included paths can be further broken down into the following two
types: Explicit Inclusions and Wildcard Inclusion.
MDF, NDF, and
LDF Files

Microsoft Office SharePoint Server content database files used as
the source. The three files work as a collection to comprise a single
content database. You must have one MDF, one or more LDF, and
optionally zero or more NDF files.
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Term
Metadata

Description
Data about data. For example, the title, subject, author, and size of a
file constitute metadata about the file.

Non-series List A non-series list is a special list created for meeting workspaces and
have specific instances of the meeting assigned to the list.
Previous
Versions

Items, such as documents and pictures, create a backup copy
whenever it is saved to the library in Microsoft Office SharePoint
Server. These previous versions are accessible in Ontrack
PowerControls.

Series List

A series list provides a way to have a regular list in a recurring
meeting workspace. A series list shows all of the items for all
occurrences of a meeting.

Shortcut Menu

This menu is accessed by right-clicking on an item.

Site

A group of related web pages that generally cover one or more lists
and folders.

Site Collection

A set of websites that have the same owner and share
administration settings. Each site collection contains a top-level
website and can contain one or more subsites.

Source

The Microsoft Office SharePoint Server content database stored on
a Microsoft Office SharePoint Server from which folders and lists are
copied. The source is read-only, so items cannot be copied into,
deleted from, or changed in the source.

Target

The data store to which lists, folders, and items are restored.

Wildcard
Inclusion

Selected in Managed Paths, wildcard inclusion includes any sites
below the path that you set, so you do not have to add them
individually. This is the type of inclusion to use for specific site
names that are appended to the URL, when you want to be able to
create top-level websites underneath a specific path, such as /sites.
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